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DO NOT USE THIS PRODUCT IN LIFE SUPPORT SYSTEMS.

LIFE SUPPORT POLICY

ZILOG’S PRODUCTS ARE NOT AUTHORIZED FOR USE AS CRITICAL COMPONENTS IN LIFE 
SUPPORT DEVICES OR SYSTEMS WITHOUT THE EXPRESS PRIOR WRITTEN APPROVAL OF 
THE PRESIDENT AND GENERAL COUNSEL OF ZILOG CORPORATION. 

As used herein

Life support devices or systems are devices which (a) are intended for surgical implant into the body, or (b) 
support or sustain life and whose failure to perform when properly used in accordance with instructions for 
use provided in the labeling can be reasonably expected to result in a significant injury to the user. A criti-
cal component is any component in a life support device or system whose failure to perform can be reason-
ably expected to cause the failure of the life support device or system or to affect its safety or effectiveness.

Document Disclaimer

©2012 Zilog, Inc. All rights reserved. Information in this publication concerning the devices, applications, 
or technology described is intended to suggest possible uses and may be superseded. ZILOG, INC. DOES 
NOT ASSUME LIABILITY FOR OR PROVIDE A REPRESENTATION OF ACCURACY OF THE 
INFORMATION, DEVICES, OR TECHNOLOGY DESCRIBED IN THIS DOCUMENT. ZILOG ALSO 
DOES NOT ASSUME LIABILITY FOR INTELLECTUAL PROPERTY INFRINGEMENT RELATED 
IN ANY MANNER TO USE OF INFORMATION, DEVICES, OR TECHNOLOGY DESCRIBED 
HEREIN OR OTHERWISE. The information contained within this document has been verified according 
to the general principles of electrical and mechanical engineering. 

Z8051 is a trademark or registered trademark of Zilog, Inc. All other product or service names are the 
property of their respective owners. 

Warning:
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Each instance in the Revision History table below reflects a change to this document from 
its previous version.

Date
Revision 
Level Description Page

Sep 
2012

05 Updates for Z8051 Installation Software release 2.0. 17, 23, 
30, 43–
44

Apr 
2012

04 Updated for improved usability. All

Mar 
2012

03 Corrected formatting issue. n/a

Mar 
2012

02 Added a G to end of part number to indicate RoHS compliance; added 
Figure 18; changed from preliminary status.

21

Mar 
2012

01 Original issue. All



UM024205-1012 Table of Contents

Z51F0811 Evaluation Kit
User Manual

iv

Table of Contents

Revision History. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .iii

List of Figures. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . v

List of Tables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . vii

Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

Kit Contents  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

Supported Operating Systems . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

Z51F0811 Evaluation Board Block Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

Z51F0811 Evaluation Board Description . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

Install the Z8051 OCD Software and Documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

Z8051 OCD Driver Installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

FTDI USB-to-UART Driver Installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Configure the Z8051 OCD and Z51F0811 Evaluation Board . . . . . . . . . . . . . . . . . . . . . 15

Build and Run the Z51F0811 Demo Project  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Using the Keil µVision IDE on a Demo Project . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

HyperTerminal Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

Sample Projects and Documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

Schematic Diagrams. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

Appendix A. OCD Driver Installation on Windows Vista Systems . . . . . . . . . . . . . . . . 37

Appendix B. OCD Driver Installation on Windows XP Systems . . . . . . . . . . . . . . . . . . 40

Appendix C. Stand-Alone Flash Programming Using the Keil µVision IDE . . . . . . . . . 43

Customer Support. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45



Z51F0811 Evaluation Kit
User Manual

v

List of Figures

Figure 1. The Z51F0811 Evaluation Kit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

Figure 2. Z51F0811 Evaluation Board  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

Figure 3. Block Diagram of the Z51F0811 Evaluation Board  . . . . . . . . . . . . . . . . . . . 3

Figure 4. Install Device Driver Dialog, Windows 7 . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Figure 5. Browse For Driver Dialog, Windows Vista . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Figure 6. Can’t Verify Publisher Dialog, Windows Vista  . . . . . . . . . . . . . . . . . . . . . . 8

Figure 7. Successfully Installed Dialog, Windows Vista  . . . . . . . . . . . . . . . . . . . . . . . 9

Figure 8. Unsuccessful Installation, Scenario 1  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

Figure 9. Unsuccessful Installation, Scenario 2  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Figure 10. Device Manager Dialog, Windows 7 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Figure 11. A Successful USB-to-UART Driver Installation . . . . . . . . . . . . . . . . . . . . . 14

Figure 12. Connecting the 10-Circuit Cable to the Board . . . . . . . . . . . . . . . . . . . . . . . 15

Figure 13. Connecting the USB Mini-B Cable to the Board  . . . . . . . . . . . . . . . . . . . . 16

Figure 14. An Example Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Figure 15. Initial OCD Screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

Figure 16. Object File Dialog  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

Figure 17. Configuration Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

Figure 18. A Typical On-Chip Debugger Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Figure 19. A Typical On-Chip Debugger with Child Windows Open  . . . . . . . . . . . . . 22

Figure 20. Reset & Go Toolbar Icon . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

Figure 21. Selecting the Demo Project File  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

Figure 22. Selecting the Target . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

Figure 23. Selecting the Target Driver  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

Figure 24. Configuring the Debug Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

Figure 25. Configuring the Flash Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

Figure 26. Beginning a Debug Session . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

Figure 27. A Default Debug Session . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

Figure 28. Demo Program Menu in HyperTerminal . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
UM024205-1012 List of Figures



Z51F0811 Evaluation Kit
User Manual

vi
Figure 29. Z51F0811 Evaluation Board, #1 of 2  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

Figure 30. Z51F0811 Evaluation Board, #2 of 2  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

Figure 31. Found New Hardware Dialog, Windows Vista . . . . . . . . . . . . . . . . . . . . . . 37

Figure 32. Install Device Driver Dialog, Windows Vista . . . . . . . . . . . . . . . . . . . . . . . 38

Figure 33. Couldn’t Find Driver Dialog, Windows Vista . . . . . . . . . . . . . . . . . . . . . . . 39

Figure 34. The Found New Hardware Wizard Welcome Screen  . . . . . . . . . . . . . . . . . 40

Figure 35. The Found New Hardware Wizard’s Browse Screen  . . . . . . . . . . . . . . . . . 41

Figure 36. Selecting A Target Driver For Flash Programming . . . . . . . . . . . . . . . . . . . 43

Figure 37. Configuring Additional Flash Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44

Figure 38. The Keil IDE Flash Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
UM024205-1012 List of Figures



UM024205-1012 List of Tables

Z51F0811 Evaluation Kit
User Manual

vii

List of Tables

Table 1. Z51F0811000KITG Contents  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

Table 2. Z51F0811 Evaluation Kit Sample Projects . . . . . . . . . . . . . . . . . . . . . . . . . 33

Table 3. Z51F0811 Evaluation Kit Documentation . . . . . . . . . . . . . . . . . . . . . . . . . . 33



Z51F0811 Evaluation Kit
User Manual

1

Introduction

This manual describes how to set up Zilog’s Z51F0811 Evaluation Kit (Zilog part number 
Z51F0811000KITG) and use it to evaluate your Z8051-based designs and applications.

The Kit features a small Evaluation Board consisting of four LEDs, three pushbuttons, 
port pin headers and a UART-to-USB port. The Board features the Z51F0811 MCU in a 
32-pin QFN package, plus a DBG connector to connect the board to a host development 
PC using the Z8051 USB On-Chip Debugger (OCD) cable. For more details about the 
Z51F0811 MCU, please refer to the Z51F0811 Product Specification (PS0296).

This document guides you through the following tasks:

• Install the Z8051 OCD Software and Documentation – see page 5

• Configure the Z8051 OCD and Z51F0811 Evaluation Board – see page 15

• Build and Run the Z51F0811 Demo Project – see page 17

Figure 1 displays an image of the Z51F0811 Evaluation Kit.

Figure 1. The Z51F0811 Evaluation Kit
UM024205-1012 Introduction
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Kit Contents

Table 1 lists the contents of the Z51F0811 Evaluation Kit.

Figure 2 displays an image of the Z51F0811 Evaluation Board.

Supported Operating Systems

The Z51F0811 Evaluation Board and the Z8051 On-Chip Debugger support the following 
operating systems:

• Microsoft Windows XP

• Microsoft Windows Vista (32-bit/64-bit)

Table 1. Z51F0811000KITG Contents

Item Description Quantity

1 Z51F0811 Evaluation Board 1

2 Z8051 USB On-Chip Debugger (OCD) 1

3 Z8051 OCD Target Cable (10ckt) 1

4 USB Cable: A (male) to Mini-B 2

5 Z8051 OCD Software and Documentation CDROM 1

6 Z51F0811 Evaluation Kit Insert (FL0138) 1

Figure 2. Z51F0811 Evaluation Board
UM024205-1012 Introduction
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• Microsoft Windows 7 (32-bit/64-bit)

Z51F0811 Evaluation Board Block Diagram

Figure 3 displays a block diagram of the Z51F0811 Evaluation Board.

Z51F0811 Evaluation Board Description

The Z51F0811 Evaluation Board contains the following components:

• Z51F0811: U1, 32-pin QFN chip

• 3 LEDs: green (D1), red (D2) and yellow (D3) are connected to the GPIO pins of the 
Z51F0811 MCU

• 1 green LED to indicate USB power: D4

• 3 pushbuttons:

– SW1: RESET

– SW2 and SW3 are connected to the GPIO pins on the Z51F0811 MCU

• USB connector: P1

• OCD connector: J1, J2

• USB to UART interface: U2

Figure 3. Block Diagram of the Z51F0811 Evaluation Board 
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• USB interface provides power and communication to the Board

• Test points J11 and J12 are connected to Ground; J3–J10 are connected to GPIO pin U1

When the Board is connected to the USB port of the host PC, the green D4 LED will illu-
minate (turn ON). 

Schematic diagrams of the Z51F0811 Evaluation Board are presented on pages 35 through 
36 of this document.

The physical dimensions of the Board are: 1.61" x 0.76" (40.9 mm x 19.3 mm). 
UM024205-1012 Introduction
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Install the Z8051 OCD Software and 
Documentation

The Z8051 On-Chip Debugger (OCD) interface is the interface by which your PC will 
communicate with the Z51F0811 MCU to download and execute code. In addition to the 
OCD, software such as development tools and sample applications will be installed.

If you have already installed the Z8051 software and documentation from the CD-ROM 
following the procedure on the paper insert in your kit (FL0138), skip this section and pro-
ceed to the Z8051 OCD Driver Installation section, below.

Observe the following procedure to install the Z8051 On-Chip Debugger software and 
documentation on your computer.

1. Ensure that the OCD interface hardware is not connected to your PC.

2. Insert the Z8051 Software and Documentation CD into your computer’s CD-ROM 
drive. The setup program launches automatically. If the setup program does not launch 
automatically, open Windows Explorer, browse to your CD-ROM drive, and double-
click the file labeled Z8051_<version_number>.exe.

In this filename, <version_number> refers to the version number of the OCD Software 
and Documentation release. For example, this version number may be 1.0.

3. Follow the on-screen instructions to complete the OCD software installation.

Z8051 OCD Driver Installation

The driver programs for the Z8051 On-Chip Debugger are copied during the software and 
documentation installation. In the following procedure for PCs running Windows 7 32- 
and 64-bit operating systems, ensure that the target side of the OCD will remain uncon-
nected while you install these drivers. 

If you are running Windows Vista, see Appendix A. on page 37 to install your device driv-
ers. If you are running Windows XP, see Appendix B. on page 40.

Note:

Note:

Note:
UM024205-1012 Install the Z8051 OCD Software and Documentation
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1. Connect the OCD hardware to the USB port of your PC by connecting the A (male) 
end of one of the two USB A (male)-to-Mini-B cables with the host PC’s USB port. 
Connect the Mini-B end to the OCD device.

2. After the PC detects the new hardware, it will display the Installing device driver soft-
ware dialog shown in Figure 4.

3. Select Browse my computer for driver software (advanced) to display the dialog 
shown in Figure 5, which prompts you to key in or browse for the location of the .inf 
file. Depending on the type of computer you use (32- bit or 64-bit), use the Browse 
button to navigate to one of the following paths, then click the Next button.

– On 32-bit machines, use the following path: 

<Z8051 Installation>\Z8051_<version_number>\device drivers\OCD USB\x32

– On 64-bit machines, use the following path: 

<Z8051 Installation>\Z8051_<version_number>\device drivers\OCD USB\x64

Figure 4. Install Device Driver Dialog, Windows 7

IMPORTANT NOTE: If you should encounter the scenarios presented in Figures 8 or 9, right-click your 
mouse on ZILOG OCD I/F (highlighted in Figure 8) or Unknown device (highlighted in Figure 9) and 
select Update Driver Software... 
UM024205-1012 Install the Z8051 OCD Software and Documentation
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Figure 5. Browse For Driver Dialog, Windows Vista
UM024205-1012 Install the Z8051 OCD Software and Documentation
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4. When Windows prompts you whether to install or not install, as shown in Figure 6, 
click Install this driver software anyway and wait until the installation is completed 
(Windows may prompt you more than once). 

Figure 6. Can’t Verify Publisher Dialog, Windows Vista
UM024205-1012 Install the Z8051 OCD Software and Documentation
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5. When the installation is complete, the screen shown in Figure 7 will appear. Click 
Close to exit the OCD driver installation.

On some installations, the Found New Hardware screen shown in Figure 7 may also dis-
play the text string, Zilog Z8051 USB OCD - No Firmware. This occurrence is normal 
and can be disregarded.

Figure 7. Successfully Installed Dialog, Windows Vista

Note:
UM024205-1012 Install the Z8051 OCD Software and Documentation
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Figure 8. Unsuccessful Installation, Scenario 1
UM024205-1012 Install the Z8051 OCD Software and Documentation
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Figure 9. Unsuccessful Installation, Scenario 2
UM024205-1012 Install the Z8051 OCD Software and Documentation
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6. If Zilog Z8051 USB OCD appears in the Device Manager (as highlighted in 
Figure 10), the OCD driver software has been successfully installed.

Figure 10. Device Manager Dialog, Windows 7
UM024205-1012 Install the Z8051 OCD Software and Documentation
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FTDI USB-to-UART Driver Installation

An FTDI USB-to-UART driver is required to allow your PC to communicate through its 
USB port to the on-chip UART of the Z51F0811 MCU. Observe the following procedure to 
perform these connections.

1. Ensure that the USB cable is not plugged in to the Z51F0811 Evaluation Board’s P1 
connector.

2. Navigate to the following filepath and double-click the CDM20802_setup.exe file to 
begin the driver installation.

<Z8051 Installation>\Z8051_<version_number>\device drivers\FTDI Uart

3. The installation process will begin and you should observe output similar to the fol-
lowing messages on the screen of your PC:

32-bit OS detected
<installation path>\dpinstx86.exe
Installation driver
FTDI CDM driver installation process completed.

The above message may appear for a short time, but will then disappear from your window. 
This occurrence is normal.

4. When the installation is complete, plug in the Mini-B connector of the second USB 
cable into the Board, and the larger A connector into the USB port of your PC. Refer 
to Figure 14 on page 16 for guidance.

5. If the driver installation was successful, the Ports (COM & LPT) section of the Device 
Manager will display USB Serial Port (COMx) or similar message, as highlighted in 
Figure 11.

Note:
UM024205-1012 Install the Z8051 OCD Software and Documentation
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To launch the Device Manager on Windows 7 systems, launch the Start menu, enter device 
manager in the Search programs and files field, and press the Enter key.

To open the Device manager on earlier Windows systems, navigate via the following path:

Start → Control Panel → System → Hardware → Device Manager → Ports (COM& LPT)

Figure 11. A Successful USB-to-UART Driver Installation

Note:
UM024205-1012 Install the Z8051 OCD Software and Documentation
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Configure the Z8051 OCD and Z51F0811 
Evaluation Board

Observe the following procedure to set up and configure the Z8051 On-Chip Debugger 
and the Z51F0811 Board.

Steps number 1 to 4 present the power-up sequence. Carefully follow these steps 
to avoid encountering an improper connection or disconnection.

1. Connect the Z8051 On-Chip Debugger (OCD) to the host PC’s USB port.

2. Connect one end of the 10-circuit cable to the Z8051 OCD.

3. Connect the other end of the 10-circuit cable connector to the Z51F0811 Board’s J1 
and J2 connectors. Pin 1 of the cable connector is indicated by a red stripe, as shown 
in Figure 12.

4. Using the second USB-to-Mini-B cable, connect the standard USB end to the host 
PC’s USB port.

5. Connect the other end of this second Mini-B cable to the Z51F0811 Board’s P1 con-
nector to apply power to the Board. Note that the green LED D4 is ON; see Figure 13.

Figure 14 shows an example of a completed hardware and software setup.

Figure 12. Connecting the 10-Circuit Cable to the Board

Caution:
UM024205-1012 Configure the Z8051 OCD and Z51F0811 Evaluation 
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Figure 13. Connecting the USB Mini-B Cable to the Board

Figure 14. An Example Setup
UM024205-1012 Configure the Z8051 OCD and Z51F0811 Evaluation 
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Build and Run the Z51F0811 Demo 
Project

Observe the following procedure to build and run the Z51F0811 demo project.

If you plan to use the Keil µVision IDE, please skip to the Using the Keil µVision IDE on a 
Demo Project section on page 23.

1. Browse to the following location and double-click the build_sdcc.bat batch file to 
build the project:

<Z8051 Installation>\Z8051_<version_number>\samples\Z51F0811\Demo\build_sdcc.bat

Refer to the Z8051 Tools Product User Guide (PUG0033) for additional information about 
these project files and Small Device C Compiler (SDCC) development tools.

2. When the build is complete, the command window will prompt the user to press any 
key to continue. Proceed by pressing any key on your keyboard; as a result, a hex file 
for the demo will be created in the following path:

<Z8051 Installation>\Z8051_<version_number>\samples\Z51F0811\Demo\demo.hex

3. Set up the OCD and Evaluation Board. If you have not already configured these items, 
please return to the Configure the Z8051 OCD and Z51F0811 Evaluation Board sec-
tion on page 15.

4. Run the Z8051 OCD software. From the Start menu, navigate to All Programs → 
Zilog Z8051 Software and Documentation <version_number> → Zilog Z8051 
OCD <version_number>. Once launched, the program will display Connected, as 
shown in Figure 15.

If you encounter a message that says Disconnected, return to the Configure the Z8051 
OCD and Z51F0811 Evaluation Board section on page 15 to configure the proper power-
up sequence. If the problem persists, Zilog recommends that you review the Z8051 OCD 
Driver Installation and FTDI USB-to-UART Driver Installation sections.

Note:

Note:

Note:
UM024205-1012 Build and Run the Z51F0811 Demo Project
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For a free download of the latest version of the OCD software, visit the Zilog website and 
navigate via the Tools and Software menu to Software Downloads.

5. In the Debugger window, select Load Hex from the File menu to display the Object 
File dialog, which is shown in Figure 16.

Figure 15. Initial OCD Screen

Note:
UM024205-1012 Build and Run the Z51F0811 Demo Project
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6. In the Object file dialog, browse to the hex file that you created in Step 2 and click 
Open.

7. Click the Download button to open the Configuration dialog box, shown in Figure 17.

Figure 16. Object File Dialog
UM024205-1012 Build and Run the Z51F0811 Demo Project
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8. Click the Write button to open the On-Chip Debugger’s main window. A typical OCD 
display is shown in Figure 18; Figure 19 shows an OCD window with child windows 
open.

Figure 17. Configuration Dialog
UM024205-1012 Build and Run the Z51F0811 Demo Project
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Figure 18. A Typical On-Chip Debugger Window
UM024205-1012 Build and Run the Z51F0811 Demo Project
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Use the View menu to open the child windows. For this demonstration, the example win-
dows shown in Figure 19 do not need to be opened.

9. Click the Reset & Go toolbar icon, shown in Figure 20. As a result, LEDs D1, D2 and 
D3 on the Z51F0811 Board will blink in sequence. 

Figure 19. A Typical On-Chip Debugger with Child Windows Open

Figure 20. Reset & Go Toolbar Icon

Note:
UM024205-1012 Build and Run the Z51F0811 Demo Project
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Similar projects that you can use as references are listed in Table 2 on page 33.

Using the Keil µVision IDE on a Demo Project

Zilog’s On-Chip Debugger hardware now fully supports the Keil µVision IDE. Our target 
driver is seamlessly integrated with the Keil debugger, allowing Keil C51 users to work 
within the µVision4 environment without switching between the Keil compiler and 
Zilog’s external OCD software. In the demo project example that follows, the Z51F0811 
MCU-related project is referenced as Demo. 

This document refers to the Keil µVision IDE V4.53.0.6 (PK51 Prof. Developers Kit) or 
later.

Refer to the Z8051 Tools Product User Guide (PUG0033) for additional information about 
these project files and debugging with the Keil µVision IDE and Zilog On-Chip Debugger.

Debugger Configuration

Observe the following procedure to build and run a Z51F0811 demonstration project using 
the Keil µVision IDE.

1. Start the Keil µVsion4 IDE.

2. From the Project menu, select Open Project and navigate to the following filepath:

<Installation directory>\Z8051_<version>\samples\Z51F0811\Demo

3. Select the Demo.uvproj file and click Open; see Figure 21.

Note:

Notes:
UM024205-1012 Build and Run the Z51F0811 Demo Project
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4. Return to the Project menu and select Options for Target ‘Demo’.

5. In the Options for Target ‘Demo’ dialog that appears, click the Device tab and ensure 
that your target is properly selected for your project, as illustrated in Figure 22.

Figure 21. Selecting the Demo Project File
UM024205-1012 Build and Run the Z51F0811 Demo Project
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6. After selecting the target, click the Debug tab and select the Zilog Z8051 Target 
Driver from the Use: drop-down menu, as highlighted in Figure 23.

Figure 22. Selecting the Target
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7. Click the Settings button, located to the right of this drop-down menu, to configure 
your Debug and Flash options. The Settings dialog is displayed with the Debug 
Options tab appearing by default, as shown in Figure 24.

Figure 23. Selecting the Target Driver
UM024205-1012 Build and Run the Z51F0811 Demo Project
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When configuring the appropriate Debug option, be aware of the following stipulations:

• Checking the Peripheral continues running option means that the timers used in 
your project will run while the processor is stopped by the debugger.

• The Reset at Main option will only work if you have a main file in your project; oth-
erwise you should deselect this option.

8. Click the Flash Options tab. The Flash Options Settings dialog will appear, as shown 
in Figure 25. To select the proper options for Flash programming, refer to the 
Z51F0811 Product Specification (PS0296).

Figure 24. Configuring the Debug Options

Notes:
UM024205-1012 Build and Run the Z51F0811 Demo Project
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9. Click OK to exit the Settings dialog.

10. From the Options for Target ‘Demo’ dialog, select the Load Application at Startup 
checkbox, as shown in Figure 26, the so that the IDE will download the code upon 
connection. There is no need to select or enter an initialization file.

11. Click OK to exit the Options for Target ‘Demo’ dialog.

12. From the Project menu, select Rebuild All to rebuild all target files.

Figure 25. Configuring the Flash Options

Figure 26. Load Application at Startup Settings
UM024205-1012 Build and Run the Z51F0811 Demo Project
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13. Start your debugging session by clicking the Start/Stop Debug Session icon, as indi-
cated in Figure 27. A default Windows configuration of the debug session is shown in 
Figure 28.

Figure 27. Beginning a Debug Session

Figure 28. A Default Debug Session
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The following buttons in the Keil µVision IDE are not supported by the Zilog OCD driver:

To learn more about the full functionality of the Keil µVision IDE, please refer to the Keil 
Keil µVision4 IDE documentation.

14. From the Debug menu, select Run, or simply press the F5 key on your Windows key-
board to run the demo project. As a result, LEDs D1, D2 and D3 on the Z51F0811 
Evaluation Board will blink in sequence.

15. To stop code execution, select Stop from the Debug menu.

16. To stop your debugging session, click the Start/Stop Debug Session icon.

Refer to Appendix C. on page 43 for a discussion of Stand-Alone Flash Programming 
Using the Keil µVision IDE.

HyperTerminal Configuration

A communications program such as HyperTerminal can be used on Windows XP systems 
to view the messages from the Z51F0811 Evaluation Board. The following procedure 
examines how to configure HyperTerminal for the Z51F0811 demo project.

The HyperTerminal application is not available in Windows Vista and Windows 7 systems. 
If you are using either of these operating systems, consider using/installing different com-
munication software, such as Tera Term. Please refer to the documentation for the particu-
lar emulation software you use to configure it for communication with the Z51F0811 
Evaluation Board.

1. In HyperTerminal, select the COM port assigned to the USB-to-UART interface cable 
that is connected to the P1 connector on the Evaluation Board. 

Note:

Note:

Note:
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This COM port can be determined from the Device Manager, as described in the the FTDI 
USB-to-UART Driver Installation section on page 13.

2. Configure this port to reflect the following settings: 

– 9600 bps

– 8 data bits

– No parity

– 1 stop bit

– No flow control

3. Click the Call button to connect to the Z51F0811 Board. Upon connection, you should 
be able to see the Demo program menu shown in Figure 29.

At this point, you have successfully run the Z51F0811 demo project, but you are welcome 
to continue evaluating the demo in HyperTerminal. For additional information about how 
to create, edit, run and debug this project, please see the Z8051 Tools Product User Guide 

Figure 29. Demo Program Menu in HyperTerminal

Note:
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(PUG0033) and/or the Z8051 On-Chip Debugger and In-System Programmer User Man-
ual (UM0240).

Turn off the power by removing the USB cable from the P1 connector on the Evaluation 
Board.

Note:
UM024205-1012 Build and Run the Z51F0811 Demo Project
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Sample Projects and Documentation

A number of sample projects are included on the CD that ships with the Z51F0811 Evalu-
ation Kit, and their locations, listed in Table 2, will be accessible upon installation.

A number of Z8051-related documents are included in the Z51F0811 Evaluation Kit, and 
their locations, listed in Table 3, will be accessible upon installation. You can also find 
current versions of each of these documents on the Zilog website.

Table 2. Z51F0811 Evaluation Kit Sample Projects 

Description Location

Demo samples\Z51F0811\Demo 

Led Blink samples\Z51F0811\Led_Blink 

samples\Z51F0811\Led_Blink_Asm

Timer 0 samples\Z51F0811\Timers\Timer0 

Timer 1 samples\Z51F0811\Timers\Timer1

Timer 2 samples\Z51F0811\Timers\Timer2

Timer 3 samples\Z51F0811\Timers\Timer3

Timer 4 samples\Z51F0811\Timers\Timer4

Timer 01 samples\Z51F0811\Timers\Timer_01_16bit 

Timer 23 samples\Z51F0811\Timers\Timer_23_16bit

Table 3. Z51F0811 Evaluation Kit Documentation 

Description Document Location

Z51F0410 Product Specification PS0295 Documentation\Chip_Documentation

Z51F0811 Product Specification PS0296 Documentation\Chip_Documentation

Z51F3220 Product Specification PS0299 Documentation\Chip_Documentation

Z51F3221 Product Specification PS0300 Documentation\Chip_Documentation

Z51F6412 Product Specification PS0303 Documentation\Chip_Documentation

Z51F0410 Product Brief PB0237 Documentation\Chip_Documentation

Z51F0811 Product Brief PB0238 Documentation\Chip_Documentation

Z51F3220 Product Brief PB0239 Documentation\Chip_Documentation

Z51F3221 Product Brief PB0240 Documentation\Chip_Documentation
UM024205-1012 Sample Projects and Documentation
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Z51F6412 Product Brief PB0241 Documentation\Chip_Documentation

Z8051 OCD and ISP User Manual UM0240 Documentation\Tools_Documentation

Z51F0811 Evaluation Kit User Manual UM0242 Documentation\Tools_Documentation

Z51F3220 Development Kit User Manual UM0243 Documentation\Tools_Documentation

Z8051 Tools Product User Guide PUG0033 Documentation\Tools_Documentation

Table 3. Z51F0811 Evaluation Kit Documentation (Continued)

Description Document Location
UM024205-1012 Sample Projects and Documentation
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ematic Diagrams

Figures 30 and 31 show schematic diagrams of the Z51F0811 Evaluation Board.

Figure 30. Z51F0811 Evaluation Board, #1 of 2
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Figure 31. Z51F0811 Evaluation Board, #2 of 2

TxD_U

RxD_U

VCC_5V

R11

100K

R12

470 ohm

P1

G, mini-AB

VBUS
1

DM
2

DP
3

ID
4

GND
5

L1
FERRITE BEAD

R10
20.0K 

C6

0.1uF

R9
4.75K

C4

0.1uF

C3

4.7uF

C5

0.01uF

U2

FT232RL

USBDM
16 RTS

3
G

N
D

1
7

RI
6

NC1
8

DTR
2

VCCIO
4

3v3 OUT
17

NC
24

RESET
19

TXD
1

USBDP
15

CBUS3
14

OSCI
27

OSCO
28

G
N

D
2

18

TE
S

T
26

CBUS1
22

G
N

D
3

21

DCD
10

CTS
11

DSR
9

RXD
5

CBUS4
12

CBUS2
13

A
G

N
D

25

CBUS0
23

VCC
20

D4

GREEN

21



Z51F0811 Evaluation Kit
User Manual

37
Appendix A. OCD Driver Installation on 
Windows Vista Systems

The driver programs for the Z8051 On-Chip Debugger are copied to the development PC 
during the software and documentation installation. In the following procedure for PCs 
running Windows Vista 32- and 64-bit operating systems, ensure that the target side of the 
OCD will remain unconnected while you install these drivers. 

1. Connect the OCD hardware to the USB port of your PC by connecting the A (male) 
end of one of the two USB A (male)-to-Mini-B cables with the development PC’s 
USB port. Connect the Mini-B end to the OCD device.

2. After the PC detects the new hardware, it will display the Found New Hardware Wiz-
ard dialog box, shown in Figure 32. Click Locate and install driver software (rec-
ommended). 

3. Depending on your development PC’s User Account Control settings, Windows may 
ask for permission to continue the installation. Click Continue.

Figure 32. Found New Hardware Dialog, Windows Vista
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4. When the Insert the Disc dialog appears, as shown in Figure 33, select I don’t have 
the disc. Show me other options. Click the Next button to display the dialog that 
follows, which is shown in Figure 34.

Figure 33. Install Device Driver Dialog, Windows Vista
UM024205-1012 OCD Driver Installation on Windows Vista Systems
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5. Return to page 6 and follow Steps 3 through 6.

Figure 34. Couldn’t Find Driver Dialog, Windows Vista
UM024205-1012 OCD Driver Installation on Windows Vista Systems
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Appendix B. OCD Driver Installation on 
Windows XP Systems

The driver programs for the Z8051 On-Chip Debugger are copied during the software and 
documentation installation. On Windows XP systems, ensure that the target side of the 
OCD will remain unconnected while you install these drivers. It is important that you 
observe the following procedure; do not skip ahead until the OCD drivers are installed.

1. Connect the OCD hardware to the USB port of your PC by connecting the A-Male end 
of one of the two USB A (male)-to-Mini-B cables with the host PC’s USB port, and 
connect the Mini-B end to the OCD device.

2. After the PC detects the new hardware, it will display the Found New Hardware Wiz-
ard dialog box, shown in Figure 35. Select Install from a list or specific location 
(Advanced); then click Next. 

Figure 35. The Found New Hardware Wizard Welcome Screen
UM024205-1012 OCD Driver Installation on Windows XP Systems
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3. The next dialog box, shown in Figure 36, prompts you to enter a path or navigate to 
the directory in which the .inf file was installed. Depending on the type of computer 
you use (32- bit or 64-bit), use the Browse button to navigate to one of the following 
paths and click the Next button, leaving all other selections at their default settings.

– On 32-bit machines, use the following path:

<Z8051 Installation>\Z8051_<version_number>\device drivers\OCD USB\x32

– On 64-bit machines, use the following path:

<Z8051 Installation>\Z8051_<version_number>\device drivers\OCD USB\x64

On some installations, the Found New Hardware screen shown in Figure 35 may also dis-
play the text string, Zilog Z8051 USB OCD - No Firmware. This occurrence is normal 
and can be disregarded.

Figure 36. The Found New Hardware Wizard’s Browse Screen

Note:
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4. When Windows prompts you whether to continue the installation or stop, click the 
Continue Anyway button and wait until the installation is completed (Windows may 
prompt you more than once). When the installation is complete, click Finish.
UM024205-1012 OCD Driver Installation on Windows XP Systems
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Appendix C. Stand-Alone Flash 
Programming Using the Keil µVision IDE

Observe the following procedure to program Flash memory without debugging.

1. From the Project menu, open the Options for Target 'your project’, and click the 
Utilities tab. In the Use Target Driver for Flash Programming drop-down menu 
within the Configure Flash Menu Command pane, ensure that Zilog Z8051 Target 
Driver is selected, as indicated in Figure 37.

2. Click the Settings button to change any additional Flash options. The Settings dialog 
will appear, as shown in Figure 38.

Figure 37. Selecting A Target Driver For Flash Programming
UM024205-1012 Stand-Alone Flash Programming Using the Keil µVision 
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3. After you have selected your Flash options, click OK to exit the Flash Options dia-
log.

4. Click OK to exit the Options For Target ‘Demo’ dialog.

5. From the Flash menu of the Keil IDE (see Figure 39), select either of the following 
options:

– Select Download to program Flash memory with the current project

– Select Erase to perform a mass erase of internal Flash memory

Figure 38. Configuring Additional Flash Options

Figure 39. The Keil IDE Flash Menu
UM024205-1012 Stand-Alone Flash Programming Using the Keil µVision 
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Customer Support

To share comments, get your technical questions answered, or report issues you may be 
experiencing with our products, please visit Zilog’s Technical Support page at http://sup-
port.zilog.com.

To learn more about this product, find additional documentation, or to discover other fac-
ets about Zilog product offerings, please visit the Zilog Knowledge Base or consider par-
ticipating in the Zilog Forum.

This publication is subject to replacement by a later edition. To determine whether a later 
edition exists, please visit the Zilog website at http://www.zilog.com.
UM024205-1012 Customer Support

http://support.zilog.com
http://support.zilog.com
http://www.zilog.com/kb
http://www.zilog.com/forum
http://www.zilog.com

	Z51F0811 Evaluation Kit User Manual

	Revision History
	Table of Contents
	List of Figures
	List of Tables
	Introduction
	Kit Contents
	Supported Operating Systems
	Z51F0811 Evaluation Board Block Diagram
	Z51F0811 Evaluation Board Description

	Install the Z8051 OCD Software and Documentation
	Z8051 OCD Driver Installation
	FTDI USB-to-UART Driver Installation

	Configure the Z8051 OCD and Z51F0811 Evaluation Board
	Build and Run the Z51F0811 Demo Project
	Using the Keil µVision IDE on a Demo Project
	HyperTerminal Configuration

	Sample Projects and Documentation
	Schematic Diagrams
	Appendix A. OCD Driver Installation on Windows Vista Systems
	Appendix B. OCD Driver Installation on Windows XP Systems
	Appendix C. Stand-Alone Flash Programming Using the Keil µVision IDE
	Customer Support


